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BAB II 

LANDASAN TEORI 

 

A. Kajian Pustaka 

Kajian pustaka pada dasarnya merupakan pengkajian terhadap 

pengetahuan ilmiah yang ada. Sedangkan yang dikaji berupa teori-teori yang ada 

hubungannya dengan fenomena-fenomena yang diteliti. Masalah-masalah yang 

dikaji dalam penelitian ini antara lain: (1) Tinjauan tentang fotografi (2) Tinjauan 

tentang digital imaging (3) Tinjauan tentang fotografi dan digital imaging (4) 

Tinjauan tentang Photoshop.  

 

1. Tinjauan Tentang Fotografi 

Istilah fotografi berasal dari dua kata dalam Bahasa Yunani, yaitu photos 

yang berarti cahaya dan graphein yang berarti menggambar (Mulyanta, 2007:5). 

Sedangkan fotografi menurut Sofyan dan Hidayat merupakan sesuatu yang dibuat 

melalui proses pencahayaan dan kamar gelap (2008: 10). Sehingga dasar proses 

dari pembentukan fotografi adalah terbentuknya proses fokus sinar pada area 

sensitif yang kemudian diproses menggunakan bahan-bahan kimia hingga 

membentuk hasil objek berupa wujud gambar  dalam bentuk negatif maupun 

positif. Fotografi merupakan salah satu cabang dari lingkup seni rupa berwujud 

dua dimensi. Karya seni fotografi juga sering disebut sebagai lukisan cahaya. 

Sebuah alat yang dapat menangkap gambar dari hasil pencahayaan 

sehingga menciptakan fotografi disebut dengan kamera. sejarah awal mula kata 

kamera menurut Mulyanta berasal dari bahasa latin 'Camera Obscura' yang 

berarti kamar gelap atau dark room. Camera obscura justru telah ditemukan 

beratus-ratus tahun sebelum fotografi dikenal saat ini (2007:5). 

Seiring perkembangan zaman, dunia fotografi telah mengalami evolusi 

teknologi yang semakin maju. Sebagai buktinya adalah berkembangnya jenis 

kamera yang semakin praktis dalam penggunaannya. Contoh lain juga terdapat 

pada proses cetak foto yang awalnya cuma menggunakan film hitam putih yang 

diproses di kamar gelap hingga sekarang yang semuanya dilakukan dengan sistem 

6 
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digital. Beberapa jenis kamera yang telah diciptakan di antaranya view camera, 

range finder camera (RF camera), reflex camera, reflex lensa kembar/Twin lens 

reflex camera (TLR), reflex lensa tunggal/single lens reflex (SLR), polaroid 

camera. 

Jika dilihat dari sejarahnya, fotografi sudah ada sejak jauh sebelum 

masehi. Menurut tulisan Alma Davenport dalam Aditiawan (2011) 

mengungkapkan:  

Pada abad ke-5 Sebelum Masehi (SM), seorang pria bernama Mo Ti 

sudah mengamati sebuah gejala. Dimana apabila seseorang, apabila pada 

dinding ruangan yang gelap terdapat lubang kecil (pinhole), maka di 

bagian dalam ruang itu terefleksikan pemandangan di luar ruang secara 

terbalik lewat lubang tadi. Mo Ti adalah orang pertama yang  menyadari 

fenomena camera obscura (hlm. 3).  

 
Gambar 2.1 Camera Obscura 

(Sumber: Jfkturner,10 Oktober 2013) 

 

 

Seiring berjalannya zaman, setelah adanya penemuan camera obscura 

perkembangan kamera terus berkelanjutan dan mengalami penyempurnaan hingga 

ditemukannya kamera digital di era tahun 70-an. Kamera digital hingga saat ini 

masih mengalami perubahan dan penyempurnaan dalam fungsi, penggunaan, dan 

hasilnya. Fotografi semakin berkembang pesat semenjak kamera digital 

dipasarkan secara komersial. Dengan fasilitas kamera yang semakin canggih dan 

mudah dalam penggunaannya banyak orang-orang yang menggunakan kamera 

digital sebagai lahan bisnis ataupun hanya sekedar sebagai hobi dalam fotografi. 
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Jenis-jenis foto dalam fotografi menurut Aditiawan (2011:15) di 

antaranya: 

1. Fashion Photography 

Fashion fotografi adalah sebuah jenis fotografi yang bertujuan 

untuk melakukan display pada sebuah produk baju, pakaian atau jenis 

fashion lainnya, kebanyakan digunakan untuk promosi iklan produk 

fashion yang dimuat dalam media. 

  

Gambar 2.2 Fashion photography 

(Sumber: Merciury, 20 Desember 2013) 

 

2. Wedding Photography 

Merupakan jenis foto yang saat ini sedang menjadi trend, yaitu 

fotografi pernikahan. Merupakan jenis fotografi yang prospeknya bagus 

dalam bisnis, alasannya sederhana, orang menikah banyak dan foto ini 

relatif mudah untuk dilakukan. 

Wedding photography merupakan gabungan dari foto jurnalisme, 

art dan fashion. Di Indonesia konsep dalam foto wedding terbagi dalam 

tiga bagian di antaranya pre wedding, akad, dan seremoni.  
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Gambar 2.3 Pre wedding photography 

(Sumber: Kiki, 2011: 47) 

 

3. Portrait Photography 

Portrait photography adalah sebuah kegiatan untuk merekam tidak 

hanya wajah, namun juga karakter dan emosi orang tersebut. Jadi proses 

foto ini lebih mengutamakan wajah manusia sebagai fokus subjek 

utamanya. Seorang fotografer yang baik harus bisa mengeluarkan emosi, 

karakter, perasaan hingga mood 'suasana hati' dari subjek. 

 

Gambar 2.4 Portrait Photography 

(Sumber: Aditiawan, 2011: 30) 

 

4. Foto Produk 

Foto produk merupakan bagisan dari periklanan. karena dalam 

konsep maupun visualisasinya harus bisa mencitrakan sebuah produk. 
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Yang paling penting adalah bagaimana caranya foto tersebut dapat 

meningkatkan hasil dari penjualan barang tersebut. Ini bisa dimulai dari 

konsep yang kreatif  dan menarik dengan menggunakan angle yang 

memainkan posisi dari pengambilan gambar atau dapat pula 

menggunakan lighting dengan memberikan efek pencahayaan yang 

mendukung foto tersebut terlihat menarik. 

 

Gambar 2.5 Foto produk 

(Sumber: Kiki, 2011: 56) 

5. Foto Jurnalistik 

Foto jurnalistik secara sederhana adalah setiap foto yang diambil 

dan disebarluaskan dalam media apapun. Namun lebih rincinya foto 

jurnalistik juga mengaitkan foto dengan kejadian atau peristiwa, rekaman 

jurnalistik dapat meliputi aspek emosi, dokumentasi, perilaku, yang 

mengenai sudut pandang fotografi layak untuk dimuat. Menurut sifatnya 

dalam dunia jurnalistik, foto dapat digolongkan menjadi foto spot news, 

ekologi, hukum, musibah, upacara, tokoh, bintang (selebriti), kesenian, 

news feature, potret, olah raga dan human interest (Sofyan & Hidayat, 

2008: 10). 
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Gambar 2.6 Foto jurnalistik 

(Sumber: Aditiawan, 2011: 38) 

 

Beberapa alat-alat dasar yang digunakan oleh fotografer pada umumnya 

yaitu sebagai berikut: 

1. Kamera Digital Single Lens Reflex (DSLR) 

Kamera digital single lens reflex (DSLR) adalah kamera yang 

memanfaatkan cermin untuk mengarahkan cahaya dari lensa ke 

viewfinder. Viewfinder adalah lobang kecil di belakang kamera tempat 

mengintip objek foto. Kamera DSLR merupakan bentuk paling baru dari 

penemuan kamera dari era sebelumnya. Kamera ini mempunyai 

kelebihan dalam mengambil gambar dan menyimpannya dalam bentuk 

digital. Keunggulan kamera digital adalah karena hasilnya berupa 

gambar digital, maka gambar tersebut dapat disimpan di hard disc yang 

mampu menyimpan hingga ribuan foto (Santoso, 2010: 26). Saat ini 

hampir seluruh fotografer profesional menggunakan tipe kamera digital 

single lens reflex (DSLR) 
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Gambar 2.7 Kamera DSLR 

(Sumber: Jubilee Enterprise, 2012: 1) 

 

2. Lensa 

Menurut Santoso, lensa adalah bagian kamera yang menyalurkan 

sinar dari luar ke dalam kamera. Pada tiap-tiap lensa, jarak pusat lensa ke 

titik api tetap dan tidak berubah. titik api ini disebut focus dan jarak 

antara pusat lensa denagn titik api disebut jarak focus (focal length) 

(2010: 27). Lensa kamera sangat penting digunakan dalam proses 

pengambilan gambar yang dapat mengatur zoom serta fokus pada gambar 

yang ingin diambil. Di bagian luar lensa biasanya terdapat tiga bagian 

yaitu cincin panjang zoom, cincin diafragma dan cincin focus. Lensa 

yang berkualitas tinggi memiliki kemampuan untuk memberikan hasil 

yang memuaskan dalam hal ketajaman, kontras maupun warna. Beberapa 

jenis lensa yaitu lensa fix, lensa wide, lensa tele, lensa vario. 

 

Gambar 2.8 Jenis lensa 

(Sumber: Jubilee Enterprise, 2012: 16) 
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3. Lampu kilat (flash) 

Pada dasarnya bagian terpenting dalam fotografi yaitu adalah 

cahaya. Dengan adanya cahaya kamera dapat menangkap gambar dari 

benda maupun objek melalui lensa kamera. Lampu kilat, yaitu jenis 

lampu buatan yang mampu menyediakan cahaya yang bisa dikendalikan 

atau dikontrol. Alat ini merupakan komponen tambahan dalam kamera 

yang digunakan untuk memunculkan cahaya dalam kegelapan, maupun 

membantu dan mengendalikan cahaya tambahan sehingga menimbulkan 

kesan terang terhadap foto. Lampu kilat disebut juga dengan lampu flash. 

Lampu ini bisa juga digunakan dalam indoor maupun outdoor. 

 

 

Gambar 2.9 Lampu kilat (flash) 

(Sumber: Jubilee Enterprise, 2012: 54) 

 

4. Secure Digital (SD) Card dan Compact Flash (CF) 

Pada dasarnya, jenis media penyimpanan yang populer dalam 

lingkup kamera digital terbagi atas dua jenis yaitu Secure digital (SD 

card) dan Compact Flash card (CF Card). Kedua jenis alat tersebut 

mempunyai fungsi yang sama sebagai alat penyimpan hasil jepretan 

gambar dalam bentuk digital yang kemudian dipindah ke komputer untuk 

melakukan proses editing. Selain itu juga berfungsi untuk menyimpan 

file multimedia dan juga menyimpan data seperti file teks dan 

sebagainya. Sedangkan perbedaannya yaitu CF card mempunyai bentuk 

ukuran dimensi lebih besar dibanding dengan SD card. Ukuran kapasitas 

dari penyimpanan data itu sendiri berbeda-beda, mulai dari 1 Gigabyte 
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(GB), 2 Gigabyte (GB), 4 Gigabyte (GB), 16 Gigabyte (GB), dan 

seterusnya. 

 

Gambar 2.10 Compact flash (CF) & secure digital (SD) card 

(Sumber: Atkins, 13 November 2013) 

 

2. Tinjauan Tentang Prinsip Desain 

Secara etimologis kata „desain‟ berasal dari kata designo (Italy) yang 

berarti gambar (Jervis, 1984 dalam Agus Sachari, 2004: 3).  Kaitannya dengan 

konteks gambar, Webster Dictionary menyebutkan bahwa desain merupakan 

sketsa gagasan yang memuat konsep bentuk yang akan dikerjakan (Agus Sachari, 

2004: 8). Bruce Archer dalam Agus Sachari (1976, 2004: 6) menyatakan bahwa 

desain adalah salah satu bentuk kebutuhan badani dan rohani manusia yang 

dijabarkan melalui berbagai bidang pengalaman, keahlian, dan pengetahuannya 

yang mencerminkan perhatian pada apresiasi dan adaptasi terhadap sekelilingnya, 

terutama yang berhubungan dengan bentuk, komposisi, arti, nilai, dan berbagai 

tujuan benda buatan manusia. 

Pendapat Archer tersebut didukung dengan pengertian desain yang tertulis 

dalam Encyclopedia Britanica (dalam Agus Sachari, 2004: 8) yang dimana desain 

merupakan susunan garis atau bentuk yang menyempurnakan rencana kerja seni 

dengan memberikan penekanan khusus pada aspek proporsi, struktur, gerak, dan 

keindahan secara terpadu. Dalam mewujudkan desain tidak bisa terlepas dari 

empat unsur rupa (desain) (Sachari, 2004: 71), yakni unsur konsep, unsur rupa, 

unsur pertalian, dan unsur peranan. Lebih detail, Wucius Wong (1986: 3) 

menjelaskan bahwa: 

a. Unsur Konsep, meliputi titik, garis, bidang, dan gempal (volume) 

b. Unsur Rupa, meliputi raut (bentuk), ukuran, warna, barik (tekstur) 

c. Unsur Pertalian, meliputi arah, kedudukan, ruang, gaya berat 
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d. Unsur Peranan, meliputi imba (gaya), makna, tugas 

Proses desain juga menuntut wawasan yang luas dalam berbagai ilmu dan 

menggunakan nalar dalam proses penciptaan desain dan harus peka terhadap 

lingkungan dan unsur-unsur rupa serta mampu mengolahnya berdasarkan prinsip 

desain (R.M. Soedarsono, 1992: 186). Hakekat suatu komposisi desain yang baik, 

jika suatu proses penyusunan unsur pendukung karya seni, senantiasa 

memperhatikan prinsip-prinsip komposisi: harmoni, kontras, unity, balance, 

simplicity, aksentuasi dan proporsi. 

a. Keselarasan (harmony),  

Keselarasan merupakan perpaduan unsur-unsur yang berbeda dekat (selaras). 

Jika unsur-unsur estetik dipadu secara berdampingan maka akan timbul 

kombinasi tertentu dan timbul keserasian (Dharsono, 2004: 113). Keselarasan 

antara bagian-bagian atau komponen yang disusun untuk menjadi kesatuan 

bagian-bagian itu tidak ada yang saling bertentangan, semua cocok dan 

terpadu (Djelantik, 1999: 46) 

b. Kontras (contras),  

Kontras merupakan paduan unsur-unsur yang berbeda tajam. Tanggapan 

halus, kasar, licin, dengan alat raba menimbulkan sensasi yang kontras, suatu 

pertentangan yang dieksistensikan untuk menarik perhatian. Kontras dapat 

merangsang minat, kontras dapat menghidupkan desain, dan kontras 

merupakan bumbu komposisi dalam pencapaian bentuk (Dharsono, 2004: 

113). 

c. Kesatuan (Unity),  

Kesatuan dimaksudkan bahwa karya yang indah menunjukkan dalam 

keseluruhannya sifat yang utuh, yang tidak ada cacatnya, berarti tidak ada 

yang kurang dan tidak ada yang berlebihan (Djelantik, 1999: 42). Unity 

merupakan kohesi, konsistensi, ketunggalan atau keutuhan, dan isi pokok dari 

komposisi, efek yang dicapai dalam satu susunan atau komposisi diantara 

hubungan unsur pendukung karya, sehingga secara keseluruhan menampilkan 

kesan tanggapan secara utuh (Dharsono,2004: 117). 

d. Balance (keseimbangan),  
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Keseimbangan (balance) ialah apabila beberapa unsur karya seni dapat 

memberi rasa seimbang serta memuaskan pada kita yang melihat dan 

merasakan. Untuk mencapai keseimbangan tersebut cara yang ditempuh ialah 

dengan mengatur unsur-unsur seni secara sistematis (penempatan berurutan 

dan tertata rapi) atau asimetris yaitu penempatan acak, kanan-kiri, atas-bawah 

tidak sama namun terasa seimbang (Edy Tri Sulistyo, 2005: 98). 

e. Simplicity (kesederhanaan),  

Simplisity merupakan penyederhanaan yang selektif dan kecermatan 

pengelompokan unsur-unsur artistik dalam desain. Dharsono (2004: 121) 

membagi simplicity (kesederhanaan) ke dalam tiga aspek: 

1) Kesederhanaan unsur: artinya unsur-unsur dalam desain atau komposisi 

hendaklah sederhana, sebab unsur yang terlalu rumit sering menjadi 

bentuk yang mencolok dan penyendiri sehingga sulit diikat dalam 

kesatuan keseluruhan. 

2) Kesederhanaan struktur: suatu komposisi yang baik dapat dicapai 

melalui penerapan struktur yang sederhana, artinya sesuai dengan pola, 

fungsi, atau efek yang dikehendaki. 

3) Kesederhanaan teknik: yaitu suatu komposisi yang mungkin dapat 

dicapai dengan teknik yang sederhana. Bagaimanapun nilai estetik dan 

ekspresi sebuah komposisi, tidak ditentukan oleh kecanggihan 

penerapan perangkat bantu teknis yang sangat kompleks kerjanya. 

 

f. Emphasis (Aksentuasi) 

merupakan titik berat untuk menarik perhatian (centre of interest). Aksentuasi 

mewujudkan pusat perhatian dalam satu bidang dapat menjadi segi yang 

paling menarik di dalam desain, sehingga mengarahkan mata ke tempat atau 

objek yang menjadi pusat perhatian (Dharsono, 2004:122) 

g. Proporsi 

Pengertian yang paling dekat dengan istilah proporsi adalah perimbangan. 

Masalah komposisi unsur satu dengan yang lain harus menunjukkan kekuatan 

yang seimbang (Edy Tri Sulistyo, 2005:98). Proporsi  merupakan skala yang 

mengacu antara bagian dengan keseluruhan dari suatu desain. Warna, tekstur, 

dan garis memainkan peranan penting dalam menentukan proporsi 

(Dharsono, 2004:123). 
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3. Tinjauan tentang Digital Imaging 

Definisi seni digital (digital art) adalah istilah umum untuk berbagai 

karya seni dan praktik yang menggunakan teknologi digital sebagai bagian 

penting dari kreativitas berkarya dan proses presentasi. Sejak tahun 1970, 

berbagai nama telah digunakan untuk menggambarkan proses termasuk seni 

komputer dan seni multimedia, dan digital art itu sendiri ditempatkan di bawah 

payung besar istilah seni media baru. 

Menurut Mulyanta digital image merupakan objek nyata yang 

direpresentasikan secara elekstronis. Objek tersebut bisa bersumber dari sebuah 

dokumen, foto, barang cetakan hingga lukisan. Unsur-unsur utama dalam digital 

image adalah grid-grid yang berisi elemen objek yang sangat mendasar, yaitu 

picture element (Pixel) (2007:31) 

Sejarahnya digital imaging dimulai pada tahun 1960-1970. Pada saat itu, 

digital imaging dikembangkan oleh tentara Amerika yang merasa kalau kamera 

film memiliki banyak kekurangan. Awalnya ilmu ini dikembangkan dalam operasi 

militer KH-I I program (Aditawan, 2011: 76). 

Menurut Brahmastagi (http://brahmastagi.com/2008/06/19/what-is-

digital/: 2008) Digital Device ialah alat yang fungsi utamanya digunakan untuk 

mengambil (capture), menampilkan (showing), menyimpan (saving), mengolah 

(processing), dan mewadahi interaksi dari suatu informasi atau data tertentu 

berdasarkan kode digital binary. 

Pengertian dari gambar dijelaskan dalam Wikipedia berikut ini. Citra 

(bahasa Inggris: image) adalah kombinasi antara titik, garis, bidang, dan warna 

untuk menciptakan suatu imitasi dari suatu objek–biasanya objek fisik atau 

manusia. Citra bisa berwujud gambar (picture) dua dimensi, misalnya lukisan, 

foto, dan berwujud tiga dimensi, seperti patung (WIkipedia: 2013). 

Gambar atau image menurut Binanto (2010: 97) dibuat dengan dua cara 

yaitu bitmap dan vector: 

1. Bitmap 

Bitmap digunakan untuk foto realistik dan gambar kompleks yang 

membutuhkan detail yang halus. Wujud bitmap yaitu berbentuk titik-titik 
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yang membentuk sebuah bidang ataupun garis. Titik-titik tersebut bisa 

disebut juga dengan pixel. Masing-masing pixel ini mempunyai lokasi 

serta warna tersendiri yang secara keseluruhan membentuk sebuah 

tampilan gambar pada saat gambar diperbesar. Kehalusan tampilan 

gambar ini sangat tergantung kepada resolusi serta titik atau pixel yang 

membentuk gambar tersebut. 

Apabila gambar ini diperbesar maka ini kelihatan kotak-kotak, 

semakin besar tampilan gambar maka semakin besar pula kotak-kotak 

tersebut, yang sebetulnya merupakan tampilan pixel yang diperbesar. 

Contoh gambar bitmap antara lain photo, gambar-gambar hasil scanner 

serta gambar yang dihasilkan dari software grafis seperti Photoshop, 

Corel Photo-Paint. 

Kelemahan dari gambar jenis bitmap adalah gambar akan menjadi 

pecah dan terlihat kotak-kotak (jagged) apabila gambar tersebut 

diperbesar atau dicetak menggunakan resolusi yang lebih kecil daripada 

nilai resolusi aslinya. Format bitmap ini memerlukan ruang penyimpanan 

data yang lebih besar dibandingkan dengan format vector. 

 

 

Gambar 2.11 Gambar bitmap 

(Sumber: Greembel, 10 Oktober 2013) 

 

2. Vector 

Vector digunakan untuk garis, kotak, lingkaran, poligon, dan 

bentuk grafis lainnya yang dapat diekspresikan secara matematis dalam 

sudut koordinat, dan jarak. 

Gambar vector merupakan gambar yang terbentuk bukan dari 

kumpulan titik melainkan terbentuk dari sejumlah garis dan kurva. 

Karena gambar jenis vector ini bukan terdiri dari titik, maka apabila 
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tampilan gambar ini diperbesar tetap tidak akan kehilangan detailnya 

sehingga kualitas gambarnya tetap baik. Contoh gambar ini adalah teks 

dan logo. Software aplikasi yang sering digunakan untuk mengolah 

gambar jenis vector adalah Corel Draw, Adobe Ilustrator. 

Monitor biasanya akan menampilkan gambar dalam bentuk pixel, 

maka semua gambar baik jenis vektor maupun bitmap akan ditampilkan 

dalam bentuk pixel. Gambar ini mengandung unsur matematis seperti 

arah, ukuran sudut, ketebalan, warna, dan lain sebagainya. 

 

Gambar 2.12 Gambar vector 

(Sumber: Greembel, 10 Oktober 2013) 

 

Gambar digital dapat diciptakan dengan menggunakan alat digital yang 

mempunyai hubungan dengan komputerisasi. Beberapa alat untuk memperoleh 

gambar digital yaitu kamera DSLR dan scaner. kamera DSLR berfungsi sebagai 

penangkap gambar atau perekam gambar. Sedangkan scaner bekerja sebagai alat 

yang digunakan untuk merekam/ menduplikasikan gambar dari media kertas 

menjadi bentuk sebuah file, yang mana nantinya dapat diduplikasi kembali atau 

diedit dengan mudah. 

 

Gambar 2.13 Kamera DSLR dan Scaner 

(Sumber: www.google.com/ kamera DSLR dan scaner, 6 Oktober 2013) 
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4. Tinjauan Tentang Digital Imaging Fotografi 

Digital dan fotografi adalah satu paket, dikarenakan proses pengambilan 

gambar pada fotografi sebagai bahan dasar dalam pengolahan digital imaging juga 

berpengaruh dalam proses pengolahannya. Proses digital imaging tidak 

sepenuhnya bisa memperbaiki sebuah hasil gambar, semua itu tergantung dari 

dasar gambar atau berdasarkan kemampuan desainer dalam mengolah gambar jadi 

trsebut. Jadi kesimpulannya eksekusi foto lebih penting daripada proses digital 

imaging yang fungsinya hanya sebagai pemoles. 

Penggunaan program digital yang termasuk dalam proses digital imaging 

ini dapat dimanfaatkan untuk mengolah gambar atau memanipulasi foto (photo 

retouching). Objek yang diolah dalam progam-program tersebut dianggap sebagai 

kombinasi beberapa titik atau pixel yang memiliki kerapatan dan warna tertentu, 

misalnya, foto. Gambar dalam foto terbentuk dari beberapa kumpulan pixel yang 

memiliki kerapatan dan warna tertentu. Meskipun begitu, program yang termasuk 

dalam kelompok ini dapat juga mengolah teks dan garis, akan tetapi dianggap 

sebagai kumpulan pixel. Objek yang diimpor dari program pengolah vektor atau 

garis, setelah diolah dengan program pengolah pixel atau titik secara otomatis 

akan dikonversikan menjadi bentuk pixel/titik. 

 

 

Gambar 2.14 Photo Retouching 

(Sumber: Justin, 10 Oktober 2013) 

 

Software aplikasi digital yang menunjang dalam proses digital imaging 

antara lain Adobe Photoshop, Corel Photo-Paint, Macromedia Xres, 
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Metacreations Painter, Metacreations Live Picture, Micrografx Picture 

Publisher, Microsoft Photo Editor, QF dan Wright Image. 

Gambar atau foto yang berbentuk digital mempunyai format penyimpanan. 

Di dalam buku Wahana Komputer (2011: 31) ada beberapa format penyimpanan  

yang sesuai dengan keperluan saat gambar saat digunakan. Format tersebut di 

antaranya : 

1) Format PSD (Photoshop Document). 

2) Format BMP (Bitmap Image). 

3) Format JPG/JPEG (Joint Photographic Experts Group). 

4) Format TIFF (Tagged Image Format File). 

5) Format GIF (Graphics Interchange Format). 

6) Format PNG (Portable Network Graphics). 

7) Format EPS (Encapsulated Postscript). 

8) Format PDF (Portable Document Format), dan masih banyak lagi. 

 

5. Tinjauan Tentang Photoshop 

Photoshop adalah software yang digunakan untuk memodifikasi gambar 

atau foto secara profesional baik meliputi modifikasi objek yang sederhana 

maupun yang sulit sekalipun. Photoshop merupakan salah satu software yang 

berguna untuk mengolah gambar berbasis bitmap, yang mempunyai tool dan efek 

yang lengkap sehingga dapat menghasilkan gambar atau foto yang berkualitas 

tinggi. Kelengkapan fitur yang ada di dalam Photoshop inilah yang akhirnya 

membuat software ini banyak digunakan oleh desainer grafis profesional.  

 

Gambar 2.15 Logo Photoshop 

(Sumber: Rlungariello, 10 Oktober 2013) 

 



perpustakaan.uns.ac.id digilib.uns.ac.id 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

commit to user 

22 

 

Sejarah singkat mengenai perkembangan Photoshop yaitu dari seorang 

profesor dari Michigan (USA) bernama Glenn Knol membuat sebuah eksperimen 

untuk mengolah foto secara digital. Sang profesor bekerja keras dengan alat 

sederhana di ruang gelap (dark room) milik pribadinya. Glenn Knol memiliki dua 

orang anak yang bernama John Knoll dan Thomas Knoll. Kedua anak tersebut 

meneruskan cita-cita ayahnya untuk membuat sebuah program pengolah gambar 

secara digital tersebut. Kedua saudara tersebut berhasil menciptakan sebuah 

program aplikasi pengolah gambar yang saat itu masih sederhana. Atas penemuan 

tersebut, sebuah perusahaan bernama Image Scan memberikan lisensi. Namun 

selang satu tahun, lisensi diambil alih oleh Adobe Corporation. Kemudian 

program pengolah gambar tersebut diberi nama Adobe Photoshop (http://esanet-

brothers.blogspot.com/2013/04/pengertian-definisi-Photoshop.html).  

Versi terakhir adalah versi Adobe Photoshop CS6 (Creative Suite 6). 

Memang, pada awal terciptanya Photoshop hanya ditujukan untuk keperluan 

pengolah gambar fotografi. Akan tetapi beberapa waktu kemudian akhirnya 

mengembangkan Photoshop untuk berbagai keperluan seperti: web design (image 

ready), publishing (Photoshop), animasi (image ready), digital painting 

(Photoshop), dan bidang lainnya. 

Photoshop merupakan program aplikasi yang digunakan unuk mengedit 

sebuah gambar  (image) menjadi gambar yang lebih menarik, serta bisa mengedit 

foto dan gambar-gambar yang telah di-scan ke dalam komputer. Berbeda dengan 

program aplikasi yang digunakan dalam pembuatan desain grafis dengan 

menggunakan vector misalnya seperti coreldraw. Coreldraw merupakan aplikasi 

software yang berbasis vector, sedangkan Photoshop bekerja dengan gambar yang 

berbentuk pixel dengan efek yang beragam. 

Kelebihan dari software Photoshop dibandingkan dengan software 

editing foto lainnya di antaranya yaitu:  

1. Lebih familiar dan mudah digunakan dibanding software editing gambar 

selevel dengan software Photoshop. 

http://esanet-brothers.blogspot.com/2013/04/pengertian-definisi-photoshop.html
http://esanet-brothers.blogspot.com/2013/04/pengertian-definisi-photoshop.html
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2. Membuat tulisan dengan efek tertentu. Photoshop dapat mengubah bentuk 

tulisan menjadi lebih kreatif dan inovatif dengan tool effect yang ada di 

dalamnya.  

3. Bisa untuk memanipulasi/ merekayasa foto dan gambar yang sudah ada. Ada 

banyak kegunaan Photoshop dalam mengedit foto salah satunya menyediakan 

filter “reduce grain” (mengurangi grain) yang dapat membantu 

mengoptimalkan foto yang diambil pada kondisi kekurangan cahaya 

4. Memproses materi web. Photoshop juga digunakan untuk keperluan web, 

misalnya kompresi file gambar agar ukurannya lebih kecil, memotong gambar 

kecil-kecil (slice), dan membuat web photo gallery.  

5. Fasilitas editing gambar hingga efek variasi gambar lebih lengkap. 

6. Bisa menyimpan dalam berbagai format dengan berbagai kualitas gambar 

beserta resolusi dan ukurannya. 

7. Fasilitas efek bisa ditambah seperti menambahkan plugin tambahan. 

8. File hasil editan bisa disimpan dalam format JPG (Joint Photographic 

Experts Group) dengan kualitas bagus.  

Sedangkan kelemahan/kekurangan dari software Photoshop 

dibandingkan dengan software editing lainnya di antaranya yaitu: 

1. Photoshop dalam menciptakan image hanya bisa digunakan untuk 

menciptakan image yang statis.  

2. Dengan berkembangnya versi Photoshop sekarang ini spesifikasi komputer 

untuk menjalankan program Photoshop juga harus sudah tinggi dan yang 

pasti akan diimbangi oleh harga yang tinggi pula. 

3. Kurang bagus untuk pembuatan desain majalah atau cetak brosur dengan 

banyak teks, karena tidak bisa membuat paragraf tulisan dengan sempurna. 

4. Ukuran penyimpanan file relatif besar bila terdapat banyak layer dan ukuran 

gambar yang besar. 

5. Proses cetak dalam ukuran kertas pada umumnya, atau ukuran kertas yang 

besar relatif lebih sulit. 

6. Akan lebih rumit ketika mengedit gambar dari banyak layer yang digabung. 
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a. Pengenalan Photoshop 

Beberapa pengenalan tools pada layar Photoshop berikut ini: 

 

Gambar 2.16 Layar Photoshop 

(Sumber: Proweb, 3 Desember 2013) 

 

Keterangan : 

A. Menu Bar berisi pilihan tambahan. Isi dari menu bar tergantung pada 

tool apa yang sedang di pilih di antarannya adalah menu file, edit, 

gambar, layer, select, filter, view, baris menu ini dikelompokan 

berdasarkan topiknya. 

B. Option, berisi pilihan dari tool yang di pilih. Misalnya dipilih 

kuas/brush, maka ukuran/diameter juga opacity brush ada di sini.  

C. Document Window adalah bidang yang Berfungsi sebagai tempat 

untuk  meletakkan gambar. Biasanya ukuran canvas selalu akan sama 

dengan ukuran gambar yang ada, tetapi selalu ada pilihan dalam 

Photoshop untuk dapat merubah ukuran canvas dan gambar sesuai 

dengan kebutuhan. Apabila ingin memunculkan canvas baru biasanya 

ada tiga pilihan yaitu canvas yang putih, atau yang berwarna dan 

transparan. 

D. Pallete Well, cara cepat untuk mengakses palet brushes, tool resets dan 

Layer Comps. Juga dapat digunakan untuk meletakkan palet yang 

sering digunakan. 



perpustakaan.uns.ac.id digilib.uns.ac.id 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

commit to user 

25 

 

E. Toolbox adalah alat-alat yang berfungsi untuk memodifikasi suatu 

gambar (gambar atau foto berisi berbagai tool (perkakas) yang dipakai 

untuk mengolah gambar, menambah teks, mengedit maupun 

menampilkan gambar.). Alat-alat ini juga dikelompokkan menurut 

jenisnya dan kegunaannya. 

F. Pallete adalah area yang berguna untuk memilih atau mengatur 

berbagai parameter pada saat mengedit sebuah gambar dalam 

Photoshop. Untuk menampilkan pallete ini yaitu dengan cara memilih 

menu Window kemudian pilih pallete yang akan dimunculkan. 

 

1) Toolbox 

Menurut Oktaviani toolbox merupakan sebuah kotak yang berisi 

berbagai piranti untuk memanipulasi dan menyunting sebuah tampilan (2008: 

4). Ada satu hal yang perlu diperhatikan, bahwa ada sebagian tools yang  jika 

diklik tahan akan keluar menu baru berupa tools yang fungsinya mirip dengan 

tools yang diklik tahan. Jika salah satu tool di menu tambahan itu diklik, maka 

tools tersebutlah yang akan aktif menggantikan tools yang diklik tahan. 

Dengan demikian jika menggunakan keyboard shortcut, maka yang akan aktif 

adalah tool yang menggantikannya. 
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Gambar 2.17 Toolbox Photoshop 

(Sumber: Hero, 3 Desember 2013) 

 

Ini adalah macam-macam tools yang tersedia di Toolbox Photoshop, 

di sebelah kiri layar. 

A. Move Tool 

  
Gambar 2.18 Move Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

Fungsinya untuk memindah objek baik itu berupa teks maupun 

gambar. Cara menggunakannya, aktifkan move tool lalu pilih objek yang 

akan dipindahkan dan geser ke tempat yang diinginkan. 
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B. Marque Tool 

Tool ini digunakan untuk membuat seleksi pada gambar. Ada 

beberapa jenis yang terdapat pada tool ini. Jika diklik dan ditahan pada 

lambang ini, maka akan muncul gambar seperti berikut: 

 

Gambar 2.19 Marque Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Membuat seleksi berbentuk kotak 

2) Membuat seleksi berbentuk elips atau bulat 

3) Membuat seleksi berbentuk garis horizontal 

4) Membuat seleksi berbentuk garis vertikal 

C. Lasso Tool 

Tool ini digunakan untuk membuat seleksi juga, namun 

bentuknya lebih bebas, tidak seperti marque tool.  

Shortcut L. 

Klik-tahan dan akan muncul gambar berikut: 

 

 

Gambar 2.20 Lasso Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Membuat seleksi dengan bebas sesuai dengan gerakan tangan 

2) Membuat seleksi bebas namun lebih beraturan 

3) Membuat seleksi mengikuti gambar seperti magnet 
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D. Magic Wand Tool 

Tool ini berfungsi untuk menyeleksi juga. Penggunaannya lebih 

simpel dari lasso tool. Magic wand menyeleksi bidang berdasarkan 

perbedaan warna. 

Shortcut W. 

 

Gambar 2.21 Magic Wand Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Membuat seleksi dengan cepat 

2) Membuat seleksi berdasarkan perbedaan warna 

E. Crop Tool 

Tool ini berfungsi untuk mengubah ukuran ukuran kanvas dengan 

memotong bagian-bagian yang tidak diinginkan. Perubahan ukuran kanvas 

juga mengubah ukuran image size. 

Shortcut C. 

 

Gambar 2.22 Crop Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Memotong kanvas, bentuk yang dihasilkan kotak 

2) Membuat irisan pada image menjadi beberapa bagian 

3) Digunakan untuk memilih potongan pada sebuah desain yang telah 

dipotong sebelumnya dengan menggunakan slice tool. 

F. Eye Dropper Tool 

Tool ini berfungsi untuk memilih warna dengan cara mengkliknya 

ke warna yang diinginkan. 

Shortcut I. 
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Gambar 2.23 Eye Drop Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Memilih warna berdasarkan gambar yang dipilih 

2) Menunjukkan nilai warna yang dipilih 

3) Mengukur lebar dan tinggi (dalam pixel) 

4) Memberi catatan pada hasil desain yang dibuat 

G. Healing Brush Tool 

Healing brush, seperti namanya, fungsinya untuk menyembuhkan 

atau membetulkan bagian-bagian pada gambar yang cacat atau bernoda. 

Seperti misalnya menghilangkan jerawat pada wajah. 

Shortcut J. 

 

Gambar 2.24 Healing Brush Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Membersihkan noda, usapkan pada bagian yang ingin dibersihkan 

2) Alt+klik pada bagian yg bersih dan sapukan pada bagian bernoda 

3) Buat seleksi pada bagian yang cacat dan tarik ke bagian yang bersih 

4) Memperbaiki red eye 

H. Brush Tool 

Tool ini digunakan untuk membuat gambar atau mewarnai 

gambar. Besar ukurannya dapat diatur, serta opacity dan flow, yang 

memperngaruhi warna brush yang dihasilkan. Brush ini juga punya 

bermacam-macam bentuk. 
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Shortcut B. 

 

Gambar 2.25 Brush Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Membuat gambar dengan efek goresan kuas 

2) Membuat gambar dengan efek goresan pensil 

3) Memberi warna lain pada gambar yang telah ada 

I. Clone Stamp Tool 

Tool ini berfungsi untuk meniru gambar yang telah diseleksi 

untuk digunakan lagi berkali-kali. Mirip seperti stampel. 

Shortcut S. 

 

Gambar 2.26 Clone Stamp Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Kloning area yang diinginkan, lalu klik untuk menghasilkan area yang 

serupa 

2) Kloning area yang diinginkan, dan buat menjadi pattern baru, efenya 

adalah stempel 

J. History Brush Tool 

Tool ini berfungsi untuk membuat gambar berdasarkan history 

image. 

Shortcut Y. 

 

Gambar 2.27 History Brush Tool 

(Sumber: Graphicsara, 3 Desember 2013) 
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1) Untuk melukis image menggunakan snapshot atau state history dari 

image. 

2) Untuk melukis image menggunakan snapshot atau state history dari 

image, dengan model artistik tertentu 

 

K. Eraser Tool 

Tool ini, sesuai dengan namanya, berfungsi untuk menghapus 

bagian-bagian yang tidak diinginkan. 

Shortcut E. 

 

Gambar 2.28 Eraser Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Menghapus mengikuti gerakan mouse/pen tablet 

2) Menghapus gambar hingga memberikan layar transparant 

3) Menghapus dengan mengikuti perbedaan warna 

L. Paint Bucket Tool 

Tool ini berfungsi untuk mengisi warna pada bagian yang telah 

diseleksi 

Shortcut G. 

 

Gambar 2.29 Paint Bucket Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Memberi efek gradasi warna pada bagian yang diseleksi 

2) Memberi warna pada bagian yang diseleksi 
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M. Blur Tool 

Tool ini berfungsi untu memberi efek blur pada gambar. 

Shortcut R. 

 

Gambar 2.30 Blur Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Memberi efek blur 

2) Mempertajam gambar 

3) Memberi efek geseran pada gambar 

N. Dodge Tool  

Tool ini biasanya digunakan dalam memberi shading pada 

gambar.  

Shortcut O. 

 

Gambar 2.31 Dodge Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Mengubah warna menjadi lebih terang 

2) Mengubah warna menjadi lebih gelap 

3) Mengubah saturasi warna 

O. Pen Tool 

Pen tool mempunyai banyak fungsi. Selain bisa menggantikan 

brush untuk membuat line gambar, juga bisa membuat seleksi. 

Shortcut P. 



perpustakaan.uns.ac.id digilib.uns.ac.id 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

commit to user 

33 

 

  
Gambar 2.32 Pen Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Membuat seleksi dengan mengklik satu per satu area yang diinginkan 

2) Membuat seleksi dengan menggerakan langsung mengikuti bentuk 

3) Menambah anchor point 

4) Mengurangi anchor point 

5) Mengubah kembali bentuk dengan mengubah posisi anchor point 

P. Type Tool 

Untuk mengisikan kata-kata pada layer. Font, Size, Color, dan 

lain-lain dapat disesuaikan sesuai keinginan. 

Shortcut T. 

  
Gambar 2.33 Type Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Mengetik huruf secara horizontal 

2) Mengetik huruf secara vertikal 

3) Mengetik huruf secara horizontal dan menyeleksinya secara otomatis 

4) Mengetik huruf secara vertikal dan menyeleksinya secara otomatis 

Q. Selection Tool  

Digunakan untuk menyeleksi path yang telah dibuat dengan 

menggunakan pen tool. 

Shortcut A. 
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Gambar 2.34 Selection Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Berfungsi untuk mengaktifkan seleksi path 

2) Berfungsi untuk mengaktifkan seleksi path dan mengubah anchor 

point 

R. Rectangle Tool 

Berfungsi untuk membuat shape dengan berbagai bentuk. 

Shortcut U. 

 

Gambar 2.35 RetangeTool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Berfungsi untuk membuat shape kotak 

2) Berfungsi untuk membuat shape kotak dengan keempat ujung siku-

sikunya bulat 

3) Berfungsi untuk membuat shape elips 

4) Berfungsi untuk membuat shape poligon 

5) Berfungsi untuk membuat shape berupa garis 

6) Berfungsi untuk membuat shape dengan bentuk-bentuk yang sudah 

disediakan 

S. Hand Tool dan Rotate View Tool 

 

Gambar 2.36 Hand Tool dan Rotate View Tool 

(Sumber: Graphicsara, 3 Desember 2013) 
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1) Untuk menarik layer ke atas dan ke bawah 

2) Untuk memutar view kanvas 

T. Zoom Tool 

Tool ini berfungsi untuk memperbesar atau memperkecil layar. 

 

Gambar 2.37 Zoom Tool 

(Sumber: Graphicsara, 3 Desember 2013) 

 

U. Background dan Foreground Colour 

 

Gambar 2.38 Background dan Foreground Colour 

(Sumber: Graphicsara, 3 Desember 2013) 

 

1) Memutar balik foreground dan background colour 

2) Foreground colour / di gambar ini hitam 

3) Background colour / di gambar ini putih 

2) Tool  Menu Bar dan Option Bar 

Menu bar merupakan bagian yang berisi sekumpulan tombol atau 

pilihan yang dapat digunakan untuk melaksanakan suatu perintah tertentu 

dalam mengoperasikan Photoshop. Option bar merupakan parameter 

pendukung piranti terpilih dalam toolbox (Oktaviani, 2008: 21).  

 

 

Gambar 2.39 Tool  Menu Bar dan Option Bar 

(Sumber: Danks, 3 Desember 2013) 

 

Berikut ini adalah fungsi tools yang ada di menu bar Photoshop di 

antaranya adalah: 
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1. File: Berkaitan dengan file seperti menyimpan, membuka, export, import, 

dan cetak. 

2. Edit: Menu editing secara umum seperti cut, copy, paste, transform image, 

serta untuk mengatur preferences Adobe Photoshop. 

3. Image: Berisi editing image untuk mengatur warna, hue/saturation, 

brightness/contrast, ukuran. 

4. Layer: Berkaitan dengan manajemen layer pada image, seperti menambah 

layer, menghapus, menambah efek pada layer, serta masking. 

5. Select: Berkaitan dengan selection image. 

6. Filter: Berhubungan dengan pada Photoshop yang dapat digunakan untuk 

memberi Efek tertentu pada image. 

7. View: Digunakan untuk pengaturan view seperti zooming image, 

menampilkan skala, dan sebagainya. 

8. Window: Digunakan untuk mengatur / menampilkan window 

9. Help: Untuk menampilkan help dan tutorial Adobe Photoshop. 

 

Selain itu, terdapat juga fungsi dari tools lain yang ada di menu bar di 

antaranya adalah: 

a. Fill 

Berfungsi untuk memberi warna di dalam area seleksi atau warna 

keseluruhan kalau tidak ada seleksi dengan cara mengklik Edit > Fill. 

Warna bisa diatur di dalam windows option nya. 

b. Stroke 

Berfungsi untuk mewarnai garis di area seleksi dengan cara 

mengklik Edit > Stroke. Ketebalan dan warna bisa diatur di dalam 

windosw option nya. 

c. Transform 

Tool ini untuk mentransformasi gambar di dalam layer tertentu 

dengan cara mengklik Edit > Transform. 

1) Scale : untuk merubah besar kecilnya suatu gambar 

2) Rotate : untuk memutar gambar 
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3) Skew, distorsi, perspektif, warp : untuk merubah bentuk gambar sesuai 

keinginan. 

4) Rotate 180 : untuk memutar gambar sebesar 180 derajat. 

5) Rotate 90 CW : untuk memutar gambar sebesar 90 derajat searah 

jarum jam 

6) Rotate 90 CCW : untuk memutar gambar sebesar 90 derajat 

berlawanan arah jarum jam. 

7) Flip Horizontal : untuk memirror gambar kearah horizontal 

8) Flip Vertical : untuk memirror gambar kearah vertikal. 

d. Mode 

Untuk merubah system pewarnaan dengan cara mengklik Image 

> Mode, di antaranya : 

1) RGB : Red, Green, Blue 

2) CMYK : Cyan Magenta Yellow Black 

3) Grayscale : untuk warna Hitam Putih. 

e. Adjusment 

Untuk menentukan terang gelapnya gambar (brightness/contrast) 

dengan cara mengklik Image > Adjustment. Dapat juga untuk menentukan 

warna ( Hue/Saturation ) 

f. Image Size 

Untuk merubah besar kecilnya suatu gambar dengan cara 

mengklik Image > Image Size. Bedanya dengan di tool Transform adalah 

seluruh image berubah nilai besar kecilnya. 

g. Canvas Size 

Untuk merubah besar kecilnya background dengan cara mengklik 

Image > Canvas Size. Dan ini akan membuat gambar di layer menjadi 

terpotong. 

h. Rotate Canvas 

Untuk memutar background beserta gambar yang ada di dalam 

area gambar dengan cara mengklik Image > Rotate Canvas. 
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i. Inverse 

Untuk menyeleksi yang bukan area seleksi sebelumnya dengan 

cara mengklik Select > Inverse. Tool ini berfungsi hanya jika ada image 

atau layer yang terseleksi. 

j. Feather 

Untuk memperhalus atau membuat blur suatu gambar yang sudah 

terseleksi dengan cara mengklik Select > Feather. Ini biasanya digunakan 

pada saat pemisahan suatu objek gambar dengan background nya. 

k. Effect 

Tool untuk membuat effect ini ada semua di dalam toolbar Filter. 

l. Ruler 

Untuk menampilkan ukuran di area gambar dengan cara mengklik 

View > Ruler. Ukuran bisa diseting dengan cara klik kanan di Ruler Area 

gambar maka akan muncul satuan ukuran yang akan digunakan. Seperti 

pixel, cm , inches, dan lain-lain. 

Apabila memindahkan ruler ke dalam area gambar maka akan 

muncul suatu garis bantu berwarna biru terang. Dan garis bantu ini tidak 

akan tercetak kalau di-print. 

m. Snap 

Untuk menempatkan gambar dengan pas sesuai dengan keinginan 

dengan cara mengklik View > Snap. Apabila memindahkan suatu objek 

gambar dan sudah mengaktifkan tool snap ini maka tidak perlu kesulitan 

untuk menempatkan gambar. Bisa juga menempatkan gambar pas di 

tengah, di pinggir atau pada garis bantu. 

n. Menampilkan Tool 

Untuk menampilan tool cukup dengan mengklik toolbar windows 

maka akan muncul tool yang akan dipakai. Seperti layer, color, history, 

brush dan sebagainya. 
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3) Palette 

Menurt Oktaviani palette dalam Photoshop berfungsi mengontrol sifat 

dan kerja tombol-tombol di dalam toolbox (2008: 24). Palette merupakan 

bagian Photoshop yang berisi informasi-informasi dari dokumen aktif atau 

beberapa perintah-perintah untuk memanipulasi objek gambar atau teks. Ada 

beberapa macam palette yang ada dalam layar Photoshop di antaranya layer 

palette, history palette, navigator palette, swatches palette, style palette, dan 

colour palette. 

a. Layer Palette 

Layer adalah sebuah objek yang terpisah dan dapat dikerjakan 

tanpa menggangu objek yang lainnya, dapat dikatakan layer adalah sebuah 

kertas transparan yang dapat digambari sebuah objek, dan jika digabungkan 

dengan layer yang lain, akan membentuk kesatuan gambar yang sempurna. 

Untuk mengatur layer-layer itu, maka ada palet layer. Palet layer fungsinya 

untuk mengorganisir layers yang ada dan memberi tool dan shortcut untuk 

editing layer serta mengatur tata letak, efek yang dihasilkan dari layers yang 

saling bertumpuk itu. Di bawah ini ada gambar sebuah palet layer beserta 

penjelasannya. 

  

Gambar 2.40 Layers Palette 

(Sumber: Luyeps, 3 Desember 2013) 

https://plus.google.com/114636090031345182090
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Keterangan gambar: 

A. Link 

Digunakan untuk membuat agar bisa mengelompokkan banyak 

layer sekaligus. Cara memakainya dengan memilih nama-nama layer 

yang diinginkan (dengan Shift + Klik), kemudian klik icon ini. 

B. Layer Style 

Digunakan untuk membuat layer yang berfungsi seperti menu 

Layer > Layer Style. Antara lain berisi efek-efek untuk layer yang 

terdiri dari Drop Shadow, Inner Shadow, Outer Glow, Inner Glow, 

Bevel and Emboss, Satin, Color Overlay, Gradient Overlay, Pattern 

Overlay dan Stroke. 

C. Add Layer Mask 

Digunakan untuk menutup/melindungi sebagian/seluruh 

lapisan gambar dari proses pengeditan. 

D. New Adjustment Layer 

Digunakan untuk membuat layer yang berfungsi sebagai 

perubahan warna. Ini seperti yang ada pada menu Layer > New Fill 

Layer dan New Adjusment Layer dan. Pilihannya dibagi menjadi 3, 

untuk fill layer adalah Solid Color, Gradient dan Pattern 

Sedangkan untuk Adjusment Layer ada Brightness/Contrast, Levels, 

Curves, Exposures, Vibrance, Hue/Saturation, Color Balance, Black 

and White, Photo Filter, Channel Mixer, Invert, Posterize, Treshold, 

Gradient Map dan Selective Color 

E. Layer Group 

Digunakan untuk mengelompokkan beberapa layer menjadi 

suatu kumpulan layer, agar mempermudah proses pekerjaan yang 

menggunakan banyak sekali layer. 

F. New Layer 

Digunakan untuk membuat layer baru yang kosong, ataupun 

untuk membuat duplikat layer. Untuk membuat duplikat layer, lakukan 
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dengan cara menggeser nama layer ke icon ini. Bisa juga dengan 

shortkey Ctrl+Shift+N. 

G. Delete Layer 

Digunakan untuk menghapus layer. Aktifkan layer yang ingin 

dihapus, kemudian klik icon ini. Dalam Photoshop versi CS2, bisa juga 

dilakukan hanya dengan mengaktifkan layer kemudian tekan tombol 

delete pada keyboard (ini belum bisa dilakukan jika menggunakan 

Photoshop versi sebelumnya). Pada versi sebelumnya, aktifkan layer 

yang ingin dihapus kemudian drag ke icon tong sampah (delete layer). 

H. Layer Blending Option 

Blending mode yang ditentukan dalam option bar mengontrol 

bagaimana pixel dalam suatu gambar oleh lukisan atau alat editing. Ini 

akan membantu menentukan warna saat memvisualisasikan efek 

blending mode ini, teori sederhananya seperti di bawah ini : 

1) Warna dasar adalah warna asli dari gambar. 

2) Warna campuran adalah warna yang sudah diaplikasikan dari alat 

editing atau hasil efek-efek. 

3) Yang kemudian kedua warna di atas akan tercampur sesuai 

blending mode yang akan dipakai dan menghasilkan warna 

campuran. 

 

Gambar 2.41 Layer Blending Option 

(Sumber: Photoshopessentials, 3 Desember 2013) 
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Beberapa macam jenis dari Blending mode di antaranya 

yaitu: 

a) Normal:  mode default blending mode dimana objek mempunyai 

bentuk pixel utuh. 

b) Dissolve: merepresentasikan sifat tembus cahaya dengan 

menyebarkan secara acak pixel opaque dan transparan. 

c) Darken: menyembunyikan warna terang dan menampilkan 

warna gelap. 

d) Multiply: menghasilkan warna lebih gelap. 

e) Color Burn: mengurangi warna terang layer aktif dari layers di 

bawahnya. 

f) Linear Burn: menambah warna gelap dan mengurangi warna 

terang pada layer aktif dari layer di bawahnya. 

g) Lighten: memberikan efek terang pada objek. 

h) Screen: menyimulasikan tumpukan layer agar menghasilkn 

warna lebih terang. 

i) Color Dodge: menambahkan tingkat terang dari layer aktif pada 

layer di bawahnya.  

j) Linear Dodge: menambahkan tingkat terang di atas mode color 

dodge. 

k) Overlay: menggelapkan warna gelap dan menerangkan warna 

terang agar penggabungan  gambar lebih merata. 

l) Soft Light: memberikan  warna lebih lembut atau halus. 

m) Hard Light: memberikan cahaya agar semakin jelas atau gelap 

pada sebuah objek dengan memberi penekanan pada layer aktif. 

n) Vivid Light: menggabungkan mode dan melakukan pembakaran 

 dan warna terang dengan mengubah kontras. 

o) Linear Light: lebih fokus pada tingkat pencerahan objek (hampir 

sama dengan vivid light). 

p) Pin Light: sangat bergantung pada warna yang digunakan bila 

untuk mengganti warna. 
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q) Hard Mix: hampir sama fungsinya dengan linear dodge. 

i. Keterangan: untuk gambar CMYK, hard mix mengganti semua 

pixel dengan warna intinya (cyan, yellow, or magenta), white, 

atau black. Nilai maksimum dari warnanya adalah 100. 

r) Difference: membalikkan objek dengan mencari perbedaan 

antara tingkat terang pada layer aktif dengan layer di bawahnya. 

s) Exclusion: kegunaannya mirip dengan mode difference. 

t) Hue: menghasilkan corak warna beragam dengan mencampur 

warna hue layer aktif dengan saturasi dan luminocity layer di 

bawahnya. 

u) Saturation: menghasilkan warna menurut tingkat intensitas 

warnanya bila digunakan pada objek berwarna. 

v) Color: menggabungkan hue dan saturation layer aktif dengan 

tingkat luminocity layer di bawahnya. 

w) Luminocity: menggabungkan tingkat terang dan gelap pada 

layer aktif dengan nilai hue dan saturasi pada layer di 

bawahnya. 

I. Image Adjustment Layer 

Ini menunjukkan sebuah gambar layer yang merupakan 

pengaturan warna hasil dari New Fill/Adjusment Layer. 

J. Layer Thumbnail 

Ini adalah tampilan gambar kecil dari gambar asli itu sendiri. 

Jika layer merupakan sebuah tulisan atau teks, maka gambar 

tampilannya adalah sebuah huruf T. 

Layer ini juga menunjukkan bahwa layer ini adalah layer yang 

dalam kondisi aktif atau terpilih. Layer yang sedang aktif akan 

mempunyai warna yang berbeda dengan layer yang tidak aktif. 

Tiap sebuah layer bisa mempunyai nama yang berbeda beda. 

Secara default, Photoshop akan membuat layer dengan nomor yang 

berurutan. Nama layer ini bisa diganti dengan cara melakukan klik dua 
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kali pada nama layernya, kemudian tinggal mengetikkan nama yang 

diinginkan. 

Namun saat melakukan klik dua kali, harus tepat pada nama 

layernya, karena kalau tidak, maka justru masuk ke pengaturan Layer 

Style. Jika klik dua kali dilakukan pada Thumbnail Text Layer, maka 

akan langsung membuat blok pada layer tulisan tersebut. 

Bisa juga menyeleksi layer dengan melakukan klik kanan pada 

Thumbnail Layer > layer Transparency. Atau dengan melakukan Ctrl + 

Thumbnail Layer. 

K. Eye Ball / Visibility 

Digunakan untuk mengatur tentang tampil atau tidaknya 

sebuah layer yang sedang dikerjakan dengan Photoshop. Cara 

pakainya, dengan melakukan klik pada icon tersebut. Jika gambar 

matanya hilang, maka gambar layer/efek dari layer tersebut juga akan 

tak terlihat. 

L. Palette Menu 

Icon ini digunakan untuk menampilkan pilihan menu palet. 

Menu palet ini berhubungan dengan fungsi palet yang sedang 

ditampilkan. 

M. Opacity 

Digunakan untuk mengatur tingkat transparansi layer. Semakin 

kecil nilai persentasenya, maka layer/gambar akan semakin transparan. 

N. Fill Opacity 

Digunakan untuk mengatur tingkat transparansi layer. Namun 

tidak sama dengan opacity, karena fill ini tidak mengatur bagian yang 

merupakan layer style. Jadi pilihan fill ini akan bermanfaat jika 

menerapkan layer style. 

O. Layer Style option 

Gambar icon F pada layer ini menunjukkan bahwa pada layer 

ini terdapat efek layer style, sementara gambar segitiga di sebelah 



perpustakaan.uns.ac.id digilib.uns.ac.id 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

commit to user 

45 

 

kanan ini digunakan untuk menampilkan atau tidaknya informasi detil 

layer style yang digunakan. 

 

P. Locked layer 

Gambar icon gembok (maksudnya kunci) ini menunjukkan 

bahwa layer ini dalam kondisi terkunci. Biasanya gambar dengan 

ekstension .JPG akan mempunyai layer background yang selalu 

terkunci. Untuk membuka kunci pada layer background ini, caranya 

dengan melakukan klik dua kali pada layer tersebut, kemudian klik OK 

pada kotak dialog yang muncul. 

b. Palette history 

  
Gambar 2.42 Palette history 

(Sumber: Duke, 3 Desember 2013) 

 

Palette ini menyimpan semua perintah yang telah dikerjakan, salah 

satu fungsi yang sering digunakan dalam palette ini adalah perintah untuk 
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membatalkan perintah yaitu dengan cara mengklik item perintah yang 

dibatalkan. 

 

 

c. Palette Navigator 

 

Gambar 2.43 Palette Navigator 

(Sumber: Duke, 3 Desember 2013) 

 

Palette ini untuk mengatur persentasi ukuran tampilan gambar 

dalam dokumen aktif, yaitu dengan cara menggeser slider zoom, mengklik 

tombol zoom out dan zoom in, atau mengetikkan ukuran persentase gambar 

pada kotak zoom. 

 

d. Palette Swatches 

 

Gambar 2.44 Palette Swatches 

 (Sumber: Photoshopessentials, 3 Desember 2013) 

 

Palette ini berfungsi untuk mengganti warna foreground dan 

background dengan cara mengklik kotak warna untuk memilih warna 
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foreground, atau tekan Ctrl dan klik kotak warna untuk memilih warna 

background.  

 

 

e. Palette Styles 

 

Gambar 2.45 Palette styles 

(Sumber: Conde, 3 Desember 2013) 

 

Palette ini berfungsi untuk memilih dan memasang style pada 

objek gambar atau layer yang terpilih. 

 

f.  Palette Color 

  

Gambar 2.46 Palette Color 

(Sumber: Gunawan, 3 Desember 2013) 

 

Palette ini untuk mengganti warna foreground dan background 

dengan cara mengklik kotak background / foreground, kemudian geser 

slider untuk memilih warnanya. 

 

B. Kerangka Berpikir 
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Kerangka berpikir merupakan alur penalaran yang didasarkan pada 

masalah penelitian. Dibuat dengan maksud supaya lebih mudah dalam alur 

pemikiran yang didasarkan pada tema kajian proses dan teknik pada digital 

imaging fotografi di Yogyakarta. 

Tahap pertama dalam pembuatan produk digital imaging fotografi adalah 

konsep. Konsep yang dimaksud adalah hasil integrasi dari permintaan konsumen  

dengan imajinasi dari fotografer dan editor. Melalui konsep yang telah disepakati, 

maka akan memudahkan fotografer dalam mengeksekusi proses foto dan editing. 

Setelah melalui tahap konsep, tahap berikutnya adalah tahap 

pelaksanaan. Tahap pelaksanaan mencangkup semua aspek dalam persiapan 

proses produksi, seperti media, alat, teknik, dan juga bahan pendukung lainnya. 

Bahan dan alat merupakan hal yang harus dipersiapkan sesuai dengan konsep 

yang dibuat. Berawal dari proses foto atau pemotretan, kemudian proses editing 

dan finishing produk menggunakan digital imaging.  

Dan kemudian berlanjut ke tahap terakhir yaitu visualisasi digital 

imaging dari produk Dhiphoto Digital Photography Yogyakarta. 

Kerangka pemikiran ini  dibuat dengan maksud supaya lebih mudah 

penelitian dalam alur pemikiran yang didasarkan pada tema studi tentang digital 

imaging fotografi Dhiphoto Yogyakarta. 

Adapun penggambaran kerangka berpikir ini sebagai berikut : 
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Bagan 2.1 Bagan Kerangka Berpikir 

  

Konsep 

 

Editing Pemotretan Finishing 

Proses Digital Imaging 

Fotografi 

Dhipoto Digital Photography 

Visualisasi Produk 

Dhipoto Digital 

Photography 


